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Recall your memory
=> Face Detection

* Wide applications
Auto Focusing for Digital Cameras
Face Recognition

Video surveillance, and etc...

® Skin-Color-Based Face Detection
Simple implementation

Using fewer FPGA resources




Recall your memory => FPGA

* Reconfigurable “Versatile Chips”

Field-Programmable Gate Array (FPGA)

Memory blocks
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http://www.electronicproducts.com/Digital |Cs/Standard and Programma
ble Logic/The evolution of FPGA coprocessing.aspx



http://www.electronicproducts.com/Digital_ICs/Standard_and_Programmable_Logic/The_evolution_of_FPGA_coprocessing.aspx

e
Objectives

e To study on the image & video processing techniques, especially
ones related to face detection;

e To be familiar with the FPGA system design and develop deeper
understanding on its characteristics:

e Compared to sequential micro-processors
v Parallel Execution

=> Hardware acceleration
=> Faster processing for specific applications

e Compared to custom ASIC design
v" Reconfigurable

=> Faster prototype
Low-cost verification

e To implement an FPGA-Based Face Detection System

-




( Project Schedule A

09/2014 Background Learning and Basic Understanding Establishment v

10/2014 Trials on C Sobel Filter and get familiar with CWB & QuartusII Tools v

DE2-115 Board Experiments and Basic Function Implementation like Camera
11/2014 v
Capture, VGA Display and Simple Image Operations

Edge Detection Operation and HLS of the C Sobel Filter
12/2014 v

Interim Presentation & Report

System Design and Operation Flow Trials in Software Approach v
Hardware Single Modules Design and Functionality Verification 4
System Module Integration and Board Verification 4
Testing, Improvement, Final Report and Presentation v




a ™
Major Steps of Project Implementation

Edge Detection Trial

N

MATLAB Prototype

Adapted into
‘ hardware suitable
method

Face Detection System




e

MATLAB Working Flow [ Input Frame Images

J

Skin Segmentation/Thresholding

4

Original Gray Binarilized By Skin Color

Morphological Filtering

J

Labeling Connect Components

.

Area Calculation

4

Spatial Filtering

.

Centroid Computation

J

[ Detection Result
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DE2-115
M;::wmt VGA
. DAC
Pre-Processing i3
i =
TRDB_DSM 8 * ? 3
Camera Module
paTA| | | _[paTA VGA
ALl L eep 4-Port SDRAM ADOR . cpRAM Controller
LVALL = Controller CTRL
Sensor
€D | x| ||| D3
Image | mcik| | || Capture
Sensor Altera FPGA Cyclone IV | Color-Space Skin-Color _
sont | | 12¢ ccD converter |  [hresheldi Post-Processing
F scl Configuration | >
|

® One PLL (Phase-Locked Loop) manages the clock utilization;
® One Reset_Delay Module manages the RESET functions;
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CCD Camera Configuration By 12C

DE2-115

processors on computer motherboards or
embedded systems

* Two critical bus lines

* aserial data line (SDA) |

* a serial clock line (SCL)

Development VGA
Board
L e bus
Pre-Processing T T 17T
< x
TRDB_DSM 5850
Camera Module
A 4-POrtSDRAM  [*hoon ” ot
FVAL -Fo ADOR , snoam Controller
AL 5::5?,, Controller CTRL |
D | poix Data
Image | Mo Capture
Sensor Altera FPGA Cyclone IV | Color-Space Skin-Color .
|, SDAT 12€ CCD Converter |  [Thresholding Post-Processing
b SCLE Configuration
i CLOCK
i_GO
i_RESET |12C CCD Camera
Configuration
i W_R
[ i_mc_DAJA[slﬂ]]

o_ACK

o_END

o_I2C_SCLK

[bszc_snﬁﬂ

™~

* Multi-master, multi-slave, single-ended, seria

* Used for attaching lower-speed peripherals tc

1
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CCD Camera Configuration By 12C

*| Look-UpTable (LUT) built according to Hardware Specifications

238
240
241
242
243
244
245
246
247
248
2485
250
251
252
253
254
255
256
257
258
258
260
26l
262
263
264
265
266
2a7
268
2659
270

=

case(LUT _ INDEX)

defaalt LUT DATAR

0 : LOT DATL <= 2
1 LUT_DATA <= Z
2 LUT DATL <= {
3 LUT DATR <= 2
4 LUT_DATR <= 2
5 LUT_DATR <= 2
& LUOT DATA <= 2
7 LUOT DATA <= 2
& 1+ LUT DATR <= 2
5 : LOT DATZ <= 24!
10+ LOT DATZ <= 24
"ifdef VGA E&Gx&”ﬁpﬁﬁ
11 : LUT DATA <= 24'h111f04;
12 : LUT _DATA <= 24'h120001;
‘else
11 : LUT _DATA <= 24'R111805;
12+ LUT DATA <= 24'R120001;
endif
13 ¢ LUT DATA <= 24'R100053;
14 : LUT DATA <= 2Z4'h980000;
15 : LUT DATA <= Z4'hAOOOO0O;
16 : LUT DATA <= Z4'hAI10000;
17 : LUT DATA <= Z4'"hRIOFFE;
12 ¢+ LUT_DATAZ <= sensor Start _row
19 @ LUT DATA <= sensor_start column
20 LUT_DATLA <= sensor row_size;
21 LUT DATA <= sensor column size;
22 LOT DATA <= sensor row mode;
23 LUT DATL <= sensor column mode;
24 LOT DLTL <= EE'EE}:;AE:

f Mirror

REow and Columns
Exposure

lanking

L _Divider

PLL m Factor<<8+FLL n

LL pl Diwvider

PLL m Factor<<8+PLL n_
LL pl Diwvider

set USE PLL

disble calibration

Test pattern control
Test green pattern value
Test red pattern wvalue
Set SLCart row

get start column
Zet row =size
set column =size
set row mode in bin mode
set column mode in
row black target

Divider

bin mode
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Pre-processing

e Bayer Pattern => RGB

the pixel array of an image sensor

-- Raw image data processing

Camera Module

DATA

FVAL
LVAL

PCLK

|, MCLK

|, SOAT
|, sCLK

Pre-Processing

W ccD 4-Port SDRAM

| sensor Controller
Data

"| Capture

o [DATA _

WOOR
ICTRL

DE2-115
Development
Board

Altera FPGA Cyclone IV c°|°r_sPa¢e

12C CCD Converter

Configuration

Skin-Col
Thresholdi

Post-Processing ‘

The Bayer arrangement of color filters on

Interpolation to get RGB components
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Frame Buffer (Multi-Port SDRAM Controller)

DE2-115
oo v
. DAC
Pre-Processing i
-
TRDB_DSM s = £z
Camera Module
OATAL | 1o L foaa VGA
AL ceD 4-Port SDRAM ADOR . snRAM Controller
WAL sensor Controller CTRL
ceo | pe ||| Pt
Image | moux Capture
Sensor Altera FPGA Cyclone IV |Color-Space Skin-Color )
o SOATH 1o 12¢ CCD Converter |  [Thresholding Post-Processing
b-SLK Configuration

e Multi-Ports
® 2 writing ports + 2 reading ports

e FIFO Control

® The video frames are captured real-time
and buffered in FIFO

* Critical issues
* R/W Bandwidth (16-bit each port)
* Read/Write Synchronization
* Memory Utilization Efficiency

41
42
43
44
45
46
47
48
449
20
21
52
23
54
2
26
=)
S8
2
&0
6l
62
63
64
65
66
a7
68
&9
70
71
T2

ff FIFD Write Side 1

WE1 DATZ,

WR1,
WR1_ ADDR,

WR1 MAX ADDR,

WR1 LENGTH,

WR1 LOAD,

WR1 CLE,

// FIFO Write Side 2

WRZ DATZ,

WRZ,
WR2 ADDE,

WR2 MAX ADDR,
WRE_LENGTH,
WRE_LGFLD,

WR2Z CLK,

f{ FIFD Read Side 1

RD1 DATH,

RD1,
RD:L_ILDDR,

RD1 MAX ADDR,

RD1 LENGTH,

RD1 LOAD,

RD1_CLE,

Jf{ FIFD Read Side 2

RD2 DARTR,

RDZ,
RDZ_ADDR,
RD2_MAX ADDR,
RD2_LENGTH,
RD2_LOAD,
RD2_CLE,

™~




e

Board VGA

-

v RGB < YCbCr e | ]
=> Luminance component is separated from chrominance
component
=> used in skin segmentation

Y 0.299  0.587  0.114 R 0 Y €0, 255]
Cy |=|—=0169 —0331 0500 |-|G |+]|128| Cpel0,255]
C, 0.500 —0.419 —0.081 B 128 | C, €10,255]
(F.15)
i CLK
i RST o_EN
- * Techniques to deal with FP
i o_DATA_Y [7:0]
_ Color_Space_Conversion * Binary representation
i_DATA_R [7:0] o_DATA_Cb [7:0] . . .
(RGB2YCbCr) * Shift 10 bits to left => shift back!
i_DATA_G [7:0] o_DATA_Cr [7:0] e MAC MegaCores
-DATA B [7:0] (Multiplication & Addition)




4 ™
Skin Segmentation

DE2-115
Dw;l:.p':\ont VGA
. DAC
Pre-Processing T T
S w 2 x
TRDB_DSM §3*-0
Camera Module
wa | ] 4-PortSORAM  ["hoon ~ b
FvaL | | L -Po WDOR
VAL o Controller oy, 7 SORAM Controller
| Sensor "
D | pe| ||| P22
Image | wax| | || Capture
Sensor Altera FPGA Cyclone IV CO'OT-SPIC! Skin-Color .
L soat| | || 12C CCD Converter | [Thresholding Post-Processing
p LK Configuration

® YCbCr Chrominance Component Ranges
® Theoretical range proposed by previous scholars, D. Chai & K. N. Ngan,
"Face segmentation using skin color map in videophone applications®
77 < Ch< 127
133 < Cr<177

® Value range should be adjusted according to the real environment setting for the

reason qf Iightin g noise

- /
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Post-Processing

=>

Spatial Filtering + Temporal Filtering + Centroid Computation

TRDB_D5M
Camera Module

DATA
FVAL
LVAL

CCD | rax
Image |, MCLx
Sensor

SDAT
F SCLK

Pre-Processing

Sensor

Capture

CccD

Data

Altera FPGA Cyclone IV

-

12C CCD
Configuration

DE2-115
o | VGA
DAC
[ ]
o
£113
TA ) VGA
4-Port SDRAM R o SORAM Controller
Controller TRL
Color-Space| | Skin-Color ‘
Converter | [Thresholding Post-Processing
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Spatial Filtering

* Window Size & Threshold should be adjusted for better performance

® 9 Rows * 9 Columns = 81 pixels

® Threshold = 78

Pixel p

>0 l

Pixel p

>0 l




4 0
Temporal Fﬂterlng

® Time-Weighted Average Module
(learnt from the averaging module by Prof. Bruce Lund, Cornell University)

° Weighting for the old average and later pixel data

3 1
out_avg = 2 in_avg + 7 pixel_data
M ] . ]. . . 1 . .
ultiplication out,yg = in_avg — 7 inavg + 2 pixel_data
Bit Shifting out_avg = in_avg-in_avg >> 2 + pixel_data >> 2
Frame Pixel t t+1 t+2 t+3 t+4  t+5 t+6 t+7 t+8 t+9 t+10 t+11 t+12

Before Filtering Ull 1|1 0|1|1|1|1I0l0 1|1|

Average 0.00 0.25 0.44 0.58 0.43 0.58 0.68 0.76 0.82 0.62 0.46 0.60 0.70

el I Y Y Y EY BN FY FY Y EN N RN BN
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Centroid Computation
---To mark the faces

--- For further facial feature verification

e (Calculate the centroids of the candidate regions

® By averaging the sum of X,Y Coordinates

® At most two faces can be detected!

® Assume the two faces can only be aligned horizontally




VGA Control by FPGA ]
Green :EE; waax| | | Capture o
HSync LI | |1 comoation | | —-—_
(LT T T T
/i Horizontal Parameter
parameter H_FRONT = 16,
parameter H_SYNC = 96;
parameter H_BACK = 48;
parameter H_ACT = 640;
parameter H _BLANEKE = H_FRONT+H_SYNC+H_BACK,
parameter H_TOTAL = H_FRONT+H_SYNC+H_BACK+H_ACT,
HHHHHHHHHHHHHHHHHHHHfffHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHHH
[ vertical Parameter
parameter V_FRONT = 11;
parameter V_SYNC = 2,
parameter V_BACK = 31;
parameter V_ACT = 480;
parameter V_BLANEKE = V_FRONT+V_5YNC+V_BACK,
parameter V_TOTAL = V_FRONT+V_5YNC+V_BACK+V_ALT,

ffﬁffffHHHHHHHHHffffHHHHHHHHHHffffffHHHHHHHHHHHHHHHHHHHHHHHH .




VGA Display + Pixel Coordinates Synchronization

in_CLK

in_RST

in_EN

VGA_Ctrl Module (Only Shows Major /O Pins)

VGA Synchronization

Coordinates Generation

From post_processing

o_H_COUNT

o_V_COUNT

o_H_SYNC

o_V_SYNC

o_X_Coord

o_Y_Coord

o_Address

> Used to record the corresponding coordinates for each operating pixels;

> Post-processing causes certain cycles delay

=> Coordinate signals are delayed for specific cycles;
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Hardware Implementation Result
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Hardware Synthesis Report

)

Total logic Total Dedicated logic | Total Total memory bits | Fmax
elements combinational registers registers
functions

18,606 / 114,480 18,520/ 114,480 6,865 / 114,480 6865 0/ 3,981,312 9.74  10.8
B - G T o R
m 41 /114,480 11/ 114,480 31/114,480 31 0/ 3,981,312 N/A N/A

(<1%) (<1%) (<1%) (0%)
102 /114,480 93/ 114,480 72 /114,480 72 30,672 /3,981,312 249.63 272.7

(<1%) (<1%) (<1%) (<1%) MHz MHz
Reset_Delay 54 /114,480 54 /114,480 37/114,480 37 0/3,981,312 218.05 239.98
-(<1%) (<1%) (<1%) (0%) MHz  MHz
89 / 114,480 88 /114,480 80/114,480 80 0/ 3,981,312 272.03 295.86

(<1%) (<1%) (<1%) (0%) MHz  MHz
481/114,480  457/114,480  195/114,480 195 0/3,981,312 185.98 208.55

(<1%) (<1%) (<1%) (0%) MHz  MHz
1,645 /114,480 1,394/114,480 745/114,480 745 32,768 /3,981,312 144.7  160.05

(1%) (1%) (<1%) (<1%) MHz MHz
VGA_Ctrl 104 /114,480 104 /114,480  26/114,480 26 0/3,981,312 408.0 447.43
-(<1%) (<1%) (<1%) (0%) MHz  MHz
280/114,480  266/114,480  131/114,480 131 0/3,981,312 229.15 247.4

(<1%) (<1%) (<1%) (0%) MHz MHz
- 20,728 / 114,480 20,391 / 114,480 7,955/ 114,480 7955 59,404 / 3,981,312 166.0  183.42

(18 %) (18 %) (7%) (1%) MHz  MHz




Conclusion

--- Performance Analysis
® Functionality Achieved

® Good Functionality in Ideal Environment

(lighting conditions, simple background)

® Hardware or FPGA Resources Optimized
* Use optimized MegaCores for Altera Devices
® Use fewer logic elements (18%)

® Drawbacks

--- For the limitation of the algorithms adopted
® [Luminance Conditions

® Facial Views

® Skin-Color Objects

Finding good thresholds for different environments is hard.
Pickin g bad thresholds yields many false positives.




g Further Issues To Be Considered

* Aspect I —Algorithm View
Advanced Machine Learning Algorithms can be adopted for higher accuracy;

* AspectII - Hardware View

Customized hardware may be used, such as camera module, memory and DSPs.

* Aspect III — Design Flow View
MATLAB to HDL Coder, Complete HLS Design Flow

* Aspect IV — Performance Comparison View

Use the same algorithm for both software and hardware implementations and make
comparisons.

* AspectV — Application View

Face Detection System with real applications, like security check and etc.

-
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Thank you for your listening!

If no questions.....

Have a nice day! ©
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Recall memory => Face Detection

* Wide applications
Auto Focusing for Digital Cameras
Face Recognition

Video surveillance, and etc. ..

® Viola-Jones AdaBoost Face Detection, Neural Network Based Face

Detection, PCA-Based Face Detection

Complicated

Resource—demanding J

® Skin-Color-Based Face Detection
Simple implementation

Using fewer FPGA resources (Memory & LEs)

™~
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Hardware Summary

Function Hardware Components Core Modules
Terasic FPGA DE2-115
Development and Education
Board (Altera Cyclone IV
4CE115 FPGA device)

_ Terasic TRDB_D5M - 5 Mega ) ) )
Picture Capture ] o Picture Data Collection Unit
Pixel Digital Camera Package

Display PC Display with VGA Port VGA Display Unit

Taohle 2 — Hardware list and corresnondina tasks

Control Unit, Processing Unit,
Processing and Control Memory Unit and

Communication Unit

CODEC (NTSC/PAL) 28MHz Oscillator
Ethernet Ethernet
10/100/1000M  10/100/1000M  RS-232

uss use use Mic Lline Line |Video Port0 Port
Blaster Port  Device Host

| <= 75/2 POrt

Triple 8-bit VGA DAC

Supply Connector

Power
ON/OFF Switch Gigabit Ethernet PHY
tera US8 B[aslev

ntroller chipset ! ) Expansion Header (/15
USB Host/Slave - L i T (with Protection Diode:
Controller b 3

Altera EPCS64

HSMC Connector
nfiguration Device

- | Altera 60-nm Cyclone |
D 16x2 Module 1 A | = FPGA with 115K LEs

SOMHz Oscillator

gment Displays SMA Ext Clock Out

cos FRENEERNEERNEATIRI LIRRRRRE |

IR Receiver




EDA Tools Summary

e Altera Quartus |l 13.1
=> Verilog HDL Coding

* ModelSim-Altera Starter Edition
=> Simulation

* NEC CyberWorkBench (CWB)
=> HLS + Preliminary Simulation
=> From C to Verilog HDL

NEC  troswered by inovation
CyberlJorkBench’
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Edge Detection Trial
— SObeI Fllter g—)lc - horzontal g—; - vertical
— Spatial Derivative
(Horizontal + Vertical) 191 = [v}+ v —— gradient magnitude
DATA| | |, Edge
{zt » Bayercom Deteﬂlon
» CMOS Pa“em Dah GnV's“h SObO' F"ter
Sensor Data To Image
powk| || PN 0BG | Converter
CMOS 1 o] [ 1
e |
Image OATA
Sensor VGA
FPGA Chip Cyclone IV Controller | S » VGA
| And ] DAC
« SOATH o 126 Sensor Mult-Port SDRAM Data Request | o,y
| SCLK| | | Configuration Controller 3
; |
z c:g 2
TRDB DSM Fa> DE2-115 Development Board
. e, Only used components
Camera Module SDRAM (Only ponents) /




4 N

Gray Ongnal Gray Histogram Equalized
Edge Detected Gray Hestogram Equalized Combenation Result Gray Bmanized By Sion Coloe

Pure Skin-Color-Based Face Dete

Original Gray Binarilized By Skin Color

Geay Processed - Path A

Combined-two-path method

Result




Hardware Implementation
=> Detection Method was adjusted for hardware consideration.

Software (MATLAB) Hardware (Verilog)

Memory Resources & The whole frame image  Specific pixel data in a
Access are stored and any pixel =~ frame cannot always be
can be accessed whenever stored so they cannot be
we want; accessed whenever we
want;
Code Implementation &  Sequential execution; Parallel execution;
Timing .
Delay---Wait for the Lower CLK frequency
preceding executions; but tasks can be divided

into several cycles and
many tasks can be
handled at the same time
(Pipelines);

- /




Pre-Processing

RGE 1o Skin Color
Scale Segmentation
Space)

g
i ,Ipath A Path

tm /@.\ Noise Removal
* )

s

, D )
Post
Processing

x

\ﬁﬂm‘d Face




~ Basic System Considerations

® Tradeoff

e Store 10-bit R, G, B data
® Color Space Conversion after Frame Buffer

More bits and more memory

Higher video acquisition rate

Better synchronization of the pixel coordinates

DATA DATA
HS
FVAL ccp VGA ve
Controll
LVAL Camera [> o ontroller <1 vea
Capture Processing DAC
CCD | pok Controller =
Camera Main
Module|"Ct* Processing
L L TT |,
SDAT
. ADDR
seLk 12C Camera 4-Port SDRAM SRAM
Configuration Controller CTRL
Core
Module Board
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Synchronization

~ VGA Display + Pixel Coordinates

?ifﬁfﬁfﬁfﬁfﬁfffffffffffffffffﬁfffffffffffffffffﬁffffffffffff

Horizontal

_ . parameter
agsysposedge TCLk o mar ameter
pesin Y parameter

hvea e par ameter

end, parameter

begin

ifoLcor PAr ameter

H_Cont

fwcwparameter

OVGA_

fmcwparameter

OVGA_H_E

end F]Elr'ilﬂlEET:EEr‘
end
P vertical & tparameter
a'Iways@(pg;e-ld;: ovggflza par‘ ameter

begin

parameter

if (1 iRST_N)

_TOTAL

Vertical Parameter

Farameter
H_FRONT = 16;
H_SYNC = 95
H_BACK = 48;
H_ACT = 0d40;
H BLANK = H_FRONT+H_SYNC+H_BACK:
_TOTAL H_FRONT+H_SYNC+H_BACK+H_ACT:
H_cont f?fHEHHHHEEHffffffffffffffffffHEHHHHEEHHEHHHHEHEEHEEHHEHEHEH
V_FRONT = 11;
V_SYNC = 2:
V_BACK = 31;
V_ACT = 480;
v BLANK = V_FRONT+V_SYNC+V_BACK;

V_FRONTHV_S5YNC+V_BACK+V_ACT;

P come fffHHHHHHHHHHHHHHHHHHHHHHHHHHHfffffffffHHHHHHHHHHHHHHHHHHHHH

OVGA_V_SYNL_ZCIR
end
else
begin
if (v_Cont<v_TOTAL)
v_Cont <= v_Cont+1’bl;
else

v_Cont <= 0;

7 vertical sync

if (v_Cont==v_FRONT-1)
OVGA_V_SYNC_2clk = 1" ho;
1f (V_Cont==V_FRONT+V_SYNC-1) i
OVGA_V_SYNC_2clk = 1'b1;

end
end

assign  oRequest
assign oCurrent_x
assign oCurrent_Y

7/

sync pulse end

?
?

Front porch end

((H_Cont>=H_BLANK && H_Cont<H_TOTAL)
(H_Cont>=H_BLANK)
(V_Cont>=V_BLANK)

H_CONT-H_BLANK
V_Cont-V_BLANK

& (v_Cont>=V_BLANK & V_Cont<V_TOTAL));
11'h0
11'h0




Backup Pages for Q&A
p tag

- USB uUsSs S HIC LINE I E v V()A 5 A ~HEXTEND
D3 S/
I I .__l i A ES

t

X6 X12 X29 x23 i
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Figure 1.1 Pixel Array Description
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. black pixels

_Flrst Clear
c |1 Pixel (10,50)
zZ| |e1|R|c1|R[G1|R|G1|R]CH
£ B |G2| B |c2|B|G2 B |G2| B
3| |e1|R[G1|R[G1R|G1 R |G
8| |Blo2[B|c2/B|G2B G2 B
s| [G1|R[G1R[G1R[G1R]G1
91 B |G2| B |c2|B|G2 B |G2| B

Figure 1.2 Pixel Color Pattern Detail (Top Right Corner)
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Image Enhancement

e Can be added for better detection performance

e Luminance Enhancement
e linear lighting correction

e nonlinear lighting processing
e Proposed enhancement uses nonlinear transfer function

based on a local approach in HSV color space
e Contrast Enhancement
e Histogram Equalization
e Gaussian convolution in HSV color space
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Noise Removal

e Low-pass filters and median filters are used most often for
noise suppression or smoothing, while high-pass filters are
typically used for image enhancement.

Low-Pass Filter
=> Remove High-Frequency Noise

Median Filter
=> A nonlinear process
- to reduce impulsive, or salt-and-pepper noise
- to preserve edges in an image
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CWB HLS Flow of Design

(1) Describe ANSI-C and modify for HW.
[Steps]
A. Add input and output variables.

B. Modify descriptions which cannot be synthesized in HW.
e.g. ‘recursive call’, ‘dynamic memory allocation’, 'system call’, etc.

C. Add bit width declaration (although not necessary)
The bit width declaration of inputs and outputs is recommended to
achieve smaller area designs. Other internal variables are optimized
automatically.

Behavioral Synthesis

(1) Specify clock frequency

(2) Specify scheduling mode

(3) Specify CWB libraries, FLIB and BLIB (Refer to the Section. 1-2-1)
(4) Synthesize the design

Venﬂca’uon

Verification in CWB
(1) Simulation based verification (behavioral level, cycle accurate level)
(2) Formal verification (Property checker, C-RTL equivalence prover)




12 | modue sobed (input_row_s00 irput_row_a01 jnput_row_s02 output_row CLOCBaRESH] Pages for Q& A
' input [0:7] irput_row_al0 ; ‘linel=_ / _/sobel c:57
Inout [0:7] input_row_a01; // inefi=_/ ./20bel c:57
Input [0:7] input_row_al2 : //neRs / /sobel c:57
output [0:7] output_row | 'lineZ= / /sobel c 58
17 |irput CLOCK || 13 |wieeic
18 |inout RESET ; 45 | #include "stdio "
46 Hnclude "stdlib b
47
43 unsigned char input_row][SIZE_BUFFER];
45 unsigned char output_row;
H0
81 /* Global varables =/
hZ unsigned char line_buffer[SIZE_BUFFER][SIZE_BUFFER];
h3
% Helze
55 /* Enrity declaration : Inputs and outputs with their bitwidths =/
he f/defined for CWB HW-C
57 in ter(l:8) input_row[SIZE_BLUFFER]; //8bit for each pixel-= 0-255
hE out ter((:8) output_row; //8bit for each pixel-= 0-255
55
&0 /* Global varables =/
&1 var(:8) line_buffer]SIZE_BUFFERI[SIZE_BUFFER];
62 Hendif
&3 AP AR AL
64
65 Hfdef C
BB void sobel(i
&7 Helze
63 process sobel(H #/defined for CWB HWC
65 Hendif
70 Fflocal varables declaration
71 unsigned int X, Y;
T2 int sumX, sum’’;
73 int SUM, rewOffset, colCffset;
74
75 char Ge[3][3] =1 -2 11,
76 10.0. Ok,
77 {1.2, 1}
78
75
20 char Gy[3][3] =i{-1. 0. 1%,
21 2.0 2}
a2 1.0, 13
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Svnthesis Repnort Bv Quartus I
frowsemmary

Flow Status Successful - Fri Jan 09 00:12:45 2015
Quartus II 32-bit Version 13.0.0 Build 156 04/24/2013 5] Web Edition
Revision Mame DE2_115 CAMEEA

Top-evel Entity Mame DEZ 115 CAMERA

Family Cydone IVE

Device EF4CE115F29CT

2,255/ 114,480 ( 2 %)
Total combinational functions 1,912 f 114,980 ( 2 %)

Dedicated logic registers 1,376 [ 114,480 ({ 1 %)

Total pins 428 [ 529 (81 % )
Total virtual pins

0
Total memory bits 74,656 /3,981,312 ( 2% ) M em

Embedded Multiplier 3-bit elements 30 /532 (6 %)
Total PLLs 1/4(25%)

Q&A \

_



900006622

Entity
Line_Buffer1
sdram_pll
LineBuffer_3
PA_3

SQRT

MAC_3
Sdram_RD_FIFO
Sdram_WR._FIFO
Line_Buffer3
LineBuffer3

IP Component Mame
shift reqgister (RAM-based)
ALTPLL
Shift register (RAM-based)
PARALLEL_ADD
ALTSQRT
ALTMULT _ACCUM (MALC)
FIFO
FIFO
Shift register (RAM-based)
Shift reqgister (RAM-based)

Version
9.1
a.1
13.0
A
MfA
13.0
A
A
13.0
13.0

Backup Pages for Q&A

Altera IP or Megafunctions Used in The
Project

IF File
v Line_Buffer1.qip
v fsdram_pll. gip
LineBuffer_3.qgip
H: /Final Year Project/Kevin Codes/FPGA/DEZ_115_CAMERA_Sobel/PA_3.v
H: Final Year Project/Kevin Codes/FPGA/DEZ_115_CAMERA_Sobel/SQRT.v
MAC_3.gip
H: /Final Year Project/Kevin Codes/FPGA/DEZ_115_CAMERA_Sobel/Sdram_Control/Sdram_RD_FIFO.w
H: Final Year Project/Kevin Codes/FPGA/DEZ_115_CAMERA_Sobel/Sdram_Control/Sdram_WR_FIFQ.v
Line_Buffer3.gip
LineBuffer3.qip

Altera
Altera
Altera
Altera
Altera
Altera
Altera
Altera
A

N/A

Vend:
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* From C to Verilog HDL

RTL
Verilog

E:> Modified E:>

Kevi

/VHDL

High-Level Synthesis
By NEC CyberWorkBench (CWB)

* Preliminary simulation & verification

L. @) Benart
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ﬁsnbel
Iél--’.sabel
50
| L [&] sobel o [Anahsis | 2015401408 20:32:34 |
=) include T
- (@ testbench
= O Otherfiles
‘.. 7] sobel bper bdlpars Emor File 201411722 15:37:49
-- =) Simulation
Ié_l"ﬁsobel [Svnthesze  |RTl generste
= () Related files
sobel IFF Behavior level intemal forma... 2014/11/22 15:37:45
-- (#) Libraries
-- (&) Constraints
f#]- @ Syrithesis Analysis
= () RTL-LS_script
b =] sobel_Ev RTL (Verilog) 2014/11/22 15:40:33 I
[+- ® Other files
[=]- L} Logic syrthesis
=153 sobel
=-ORTL
- [ sobel_E.v 2014411422 15:40:33
= () Seript
- [ sobel_Etdl 2014/11/22 15:44:41
(&) Project



" Three steps to achieve breakthrough™™ "~ ="

performance (From Xilinx)

e 1. Utilize the dedicated resources

e Dedicated resources are faster than a LUT/Flip-Flop implementation and
consume less power

e Typically built with the CORE Generator tool and instantiated

e DSP48E, FIFO, Block RAM, ISERDES, OSERDES, EMAC, and MGT, for
example

e 2. Write the code for performance
e Use synchronous design methodology
e Ensure the code is written optimally for critical paths
e Pipeline when necessary

e 3. Drive your synthesis tool

e Try different optimization techniques
Add critical timing constraints in synthesis
e Preserve hierarchy
Apply full and correct constraints
Use high effort







Post_Processing 18,606 / 114,480 ( 16 |18,520 / 114,480 ( |6,865 /

114,480 (6




